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1. Štruktúra štúdie 

Počas vývoja MIS je potrebné vybrať správny typ schémy pre dátový model a vytvoriť dátový model. 

Schému, resp. dátový model je potrebné prispôsobiť konkrétnym dátam, podnikovým cieľom 

a sledovaným faktom. Výber správnej schémy nechávame na študentoch.  Úlohou tohto materiálu 

je napomôcť pri návrhu a tvorbe dátového modelu. 

Názov Dátové modely v nástroji Oracle SQL Developer Data Modeler 

Aktuálny stav Pri výučbe predmetu je používaný najčastejšie príklad s hviezdicovou schémou 

Cieľ Vytvoriť študijné materiály zaoberajúce sa procesom tvorby dátových 

modelov s ukážkami hviezdicovej schémy, schémy snehovej vločky a schémy 

súhvezdí 

Riešenie Presne definovať potrebné predpoklady a znalosti pre návrh dátového modelu 

a vytvoriť ukážkové príklady dátových modelov pomocou Oracle Data 

Modeler 

Body 

realizácie 

1. návrh a definícia potrebných predpokladov 

2. návrh a tvorba flow diagramu postupu 

3. výber vhodných ukážkových dát 

5. návrh a tvorba schém pomocou ukážkových dát 

Tab. 1 Štruktúra PŠ 2 

1.1. Cieľ 

Cieľom tejto štúdie je ukázať často používané schémy dátových modelov. Porovnať ich výhody 

a nevýhody. Celý postup tvorby dátových modelov prebieha v nástroji Oracle Data Modeler alebo 

v module Data Modeler nástroja Oracle SQL Developer. 

1.2. Otázky 

- Aké sú sledované business ciele, procesy a stratégie podniku? 

- Je návrh podriadený špecifickými KPI alebo inými udalosťami či podmienkami? 

- Aké entity modelujeme a aké vzťahy sú medzi nimi? 

- Aké je zloženie dát, kto/čo reprezentuje dimenzie? 

- Aké merateľné fakty potrebujeme, aby sme splnili požiadavky podniku? 

1.3. Postup 

Riešiteľ, resp. študent potrebuje komunikovať s riadiacou zložkou podniku. Je potrebné presne 

stanoviť požiadavky, definovať ciele podniku a pod. Potrebuje poznať vybranú stratégiu 
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implementácie dátových skladov a tomu prispôsobiť dátové modely tak, aby bolo možné ich 

v budúcnosti rozširovať. 

 

Obr. 1 Vývojový diagram - Proces návrhu a tvorby jednotlivých schém 
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Pre jednotlivé tabuľky dimenzií je potrebné pri návrhu zvoliť vhodné názvy, dátové typy, 

identifikátory a pod. Samotné prepojenie entít prebieha pomocou SQL výrazov, ako napr. ALTER 

TABLE. Dátový model sa vytvára v grafickom prostredí nástroja Oracle Data Modeler. Vyžaduje len 

základné znalosti dátových typov Oracle Databázy. Tvorba databázy je zabezpečená DDL skriptom. 

Tento skript sa vygeneruje a spustí po vytvorení dátového modelu.  

1.4. Schémy dátových modelov 

Hviezdicová schéma 

 

Obr. 2 Hviezdicová schéma 

Skladá sa z jednej tabuľky faktov a viacerých tabuliek dimenzií. Je jednoduchá na vytvorenie, dáta 

nie sú normalizované. Ako ukážku prikladáme dátový model vytvorený pre e-commerce platformu 

Olist. Dataset bol vyčistený od nepotrebných atribútov, transformovaný a zjednodušený.  

 

Obr. 3 Dátový model pre dataset trhoviska Olist 
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Vločková schéma 

 

Obr. 4 Vločková schéma 

Veľmi podobná hviezdicovej schéme. Je tu snaha normalizovať dáta, pomocou pod dimenzií. Skladá 

sa z jednej tabuľky faktov a viacerých dimenzií. Tieto dimenzie môžu obsahovať viacero tabuliek 

s pod dimenziami. Ukážkový model obsahuje dimenzie a fakty fiktívnej spoločnosti. 

 

Obr. 5 Dátový model vločkovej schémy 
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Schéma súhvezdí 

 

Obr. 6 Schéma galaxie 

Táto schéma sa niekedy nazýva aj ako schéma rodiny hviezd, schéma galaxie, schéma súhvezdí 

alebo schéma konštelácie faktov. Skladá sa z viacerých tabuliek faktov a viacerých tabuliek dimenzií. 

Sú povolené len dimenzie prvej úrovne (nemôžeme použiť pod dimenzie). Na ukážku sme použili 

Northwind Traders fiktívnu B2B databázu. 

 

Obr. 7 Dátový model schémy galaxie Northwind datasetu 
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1.5. Porovnanie schém 

 Hviezda Vločka Súhvezdie 

Prvky 1 tab. faktov  

m tab. dimenzií 

1 tab. faktov 

m tab. dimenzií 

n tab. pod dimenzií 

f tab. faktov 

m tab. dimenzií 

0 tab. pod dimenzií 

Normalizácia Nenormalizované Normalizované Normalizované 

Výkon Menej cudzích kľúčov 

– zvýšený výkon 

Viac cudzích kľúčov     

– znížený výkon 

Viac cudzích kľúčov     

– znížený výkon 

Dizajn Jednoduchý na 

tvorbu a pochopenie 

Komplikovanejší ako 

hviezdicová schéma 

Komplikovaný na 

pochopenie pri 

veľkých štruktúrach 

Úložisko Vyžaduje viac 

diskového miesta – 

vyššia redundancia 

dát 

Potrebuje menej 

diskového miesta – 

snaha potlačiť 

redundanciu dát 

Minimalizácia 

diskového miesta – 

nízka redundancia dát 

Tab. 2 Porovnanie schém dátových modelov 
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2. Návod na prácu s modulom Data Modeler 

V tejto časti si ukážeme kde získať nástroj Oracle SQL Developer s modulom Data Modeler, ako 

vypracovať dátový model a ako získať DDL skript. Do dokumentácie môžeme použiť obrázky 

dátových modelov. Na webovom sídle predmetu nájdeme inštalačné súbory pre tieto nástroje. 

Nástroje môžeme stiahnuť aj z webových stránok spoločnosti Oracle.  

2.1. Získanie nástroja Oracle SQL Developer  

Program SQL Developer stiahneme z webu: 

- www.oracle.com/database/sqldeveloper/technologies/download 

Najlepšie je vybrať verziu aj s balíčkom JDK. Nie je tak potrebné samostatne inštalovať Java Runtime 

Enviroment. Môže byť vyžadované prihlásenie resp. registrácia. Použijeme školský e-mail na 

registráciu. Stiahne sa nám súbor s príponou zip. Ten extrahujeme, vnoríme sa do priečinka 

sqldeveloper, inicializáciu spustíme kliknutím na sqldeveloper.exe 

 

Obr. 8 Výber balíčka SQL Developer 

Pri prvom spustení, dostaneme otázku o importe dát z predošlej verzie. Stačí kliknúť na No. Otvorí 

sa okno programu SQL Developer. 

http://www.oracle.com/database/sqldeveloper/technologies/download
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Obr. 9 Import dát, počas prvej inicializácie 

2.2. Prostredie nástroja Oracle SQL Developer 

Prostredie sa skladá z viacerých častí: 

1. horné menu obsahuje v prvom riadku, fixné položky, cez ktoré ovládame program, 

otvárame navigátor nástroja, prehliadač a pod. Spodná časť menu obsahuje súbor 

nástrojov, ktorý sa mení v závislosti na otvorený navigátor resp. aplikáciu v časti 3 (Data 

Modeler obsahuje iné ikony ako napr. SQL Worksheet) 

2. v ľavej časti obrazovky máme panel v ktorom nájdeme spojenia, reporty, navigačné okno 

alebo prehľadávač objektov. Táto časť sa mení, podľa toho aký nástroj si vyberieme 

v hornom menu View. Položky majú základnú sadu nástrojov, sú zobrazené pomocou 

stromovej štruktúry a pomocou myši a pravým tlačidlom vyvoláme zoznam s možnosťami 

nad konkrétnym objektom 

3. v tejto časti aktuálne vidíme úvodnú obrazovku. Po pripojení sa k databáze uvidíme 

prostredie SQL Worksheet, pre editáciu a spustenie SQL dopytov. Pri práci s Data 

Modelerom uvidíme v tejto časti tabuľu, ktorá graficky znázorňuje entity a vzťahy.  
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Obr. 10 Základný popis SQL Developera 

2.3. Tvorba dátových modelov 

Spustíme nástroj Oracle SQL Developer. Pre vyvolanie dátového dizajnéra klikneme v hornom menu 

na View → Data Modeler → Browser. V ľavej časti sa otvorí Browser, v ktorom bude prázdny dizajn 

s názvom Untitled_1. 

 

Obr. 11 SQL Developer – Data Modeler 

2.3.1. Ukladania dátových modelov 

Pred samotnou prácou na dizajne, si môžeme uložiť dizajn. V paneli Browser, použijeme pravé 

tlačidlo myši pre kliknutie na názov Untitled_1. Zo zoznamu vyberieme Save Design. 
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Obr. 12 Uloženie dizajnu 

Dizajn sa uloží ako súbor s príponou dmd a priečinok súborov, ktorý obsahuje jednotlivé objekty, 

obrázky, poznámky, popisy a pod. Ak sa pozrieme na čerstvo vytvorený a uložený dizajn, vidíme že 

máme vytvorený prázdny dizajn Relational_1. 

 

Obr. 13 Prázdny dizajn 

2.3.2. Otvorenie a editácia dátových modelov 

Panel Browser má záložku Relational Models, v ktorej vieme vytvoriť nový model alebo otvoriť už 

existujúci model. Pre zobrazenie, klikneme na model pravým tlačidlom myši a vyberieme možnosť 

Show. Rovnaký postup platí aj pre logický model, ktorý je reprezentovaný záložkou Logical Model. 
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Obr. 14 Otvorenie editora dizajnu 

Tvorba dizajnu môže začínať najprv vytvorením logického modelu a následne vygenerovaním 

relačného (fyzického) modelu alebo najprv vytvorením relačného modelu a následne 

vygenerovaním logického modelu. 

Logický model reprezentuje entity a vzťahy medzi nimi. Je určený pre potreby podniku. Fyzický 

model, je už priamo naviazaný na konkrétny typ databázy a definuje akým spôsobom budú uložené 

dáta. Budeme používať databázu od Oracle. Môžeme začať modelovať fyzický model. 

2.3.3. Pridávanie entít 

Najprv začneme pridávať tabuľky. V hornom menu sa nám rozšíril zoznam ikon. Pre pridanie tabuľky 

klikneme na ikonu New Table (Obr. 15). Kurzor sa zmení na znak +. Klikneme na ľubovoľné miesto 

a otvorí sa nové okno (Obr. 16) v ktorom budeme definovať tabuľku. 

 

Obr. 15 Pridanie tabuľky 

Základom pre vytvorenie tabuľky je vloženie názvu v General → Name a následne v záložke 

Columns špecifikujeme stĺpce tabuľky.  
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Obr. 16 Editácia tabuľky 

V každom stĺpci definujeme jeho názov, dátový typ (zvolíme Logical), zdrojový typ (podľa dát) 

a ďalšie vlastnosti ako primárny kľuč (PK) alebo povinnosť vloženia (Mandatory). Každá tabuľka 

musí mať primárny kľúč, vlastnosť povinné sa automaticky vyberie, pretože každý riadok v tabuľke 

musí byť selektovateľný a bez vloženej hodnoty by to nebolo možné. Stĺpec pridávame pomocou 

zeleného znaku +. Stĺpce vieme aj mazať, presúvať, kopírovať, komentovať alebo označiť za 

zastaralé.   

Zmeny uložíme znovu kliknutím na + (Obr. 17 krok 1) alebo na tlačidlo Apply (Obr. 17 krok 6) 

a ukončíme cez tlačidlo Ok. Ak je potrebné vytvoriť resp. upraviť pohľady, indexy a iné, editor 

tabuľky otvoríme dvojklikom na tabuľku v dizajne. 
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Obr. 17 Pridávanie a editácia stĺpcov 

Ukážková tabuľka, v ktorej budú uložené informácie o dátume je zobrazená na Obr. 18 nižšie. 

 

Obr. 18 Tabuľka dátumov 

Tento postup zopakujeme aj pre ostatné tabuľky, ktoré budú neskôr reprezentovať dimenzie 

a fakty. Pri ukladaní textov, musíme použiť dostatočne veľký počet znakov, na uloženie týchto 

textov. Pri tabuľke faktov, vytvoríme len základné stĺpce. Cudzie kľúče, si vieme vytvoriť ručne, 

alebo sa vygenerujú pomocou pridania vzťahu. Generovanie cudzích kľúčov si ukážeme 

v nasledujúcej podkapitole. 
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Obr. 19 Dátový model bez prepojení 

2.3.4. Pridávanie relácií 

Vytvorené tabuľky je potrebné poprepájať. V hornom menu nájdeme ikonu New Foreign Key (kľúč 

s šípkou). Kliknutím na ikonu sa zmení kurzor na znak + s čiarou. Teraz potrebujeme definovať 

začiatok a koniec čiary. Najprv klikneme na tabuľku reprezentujúcu dimenziu a potom na tabuľku 

faktov. Ukážku vidíme na Obr. 21 nižšie. 

 

Obr. 20 Pridanie vzťahu 

 

Obr. 21 Prepojenie dimenzie MIS_DATUM s faktom MIS_FAKT 
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Otvorí sa nové okno, v ktorom je dôležité skontrolovať prvé 3 riadky, prípadne si môžeme zmeniť 

názov vytvoreného stĺpca v tabuľke faktov. Ak sme spokojný s nastavenými parametrami, 

vytvorenie spojenia potvrdíme kliknutím na Ok. 

 

Obr. 22 Editácia parametrov vzťahu medzi MIS_DATUM a MIS_FAKT 

Medzi tabuľkami vznikla šípka. Pri tabuľke dimenzie (dátum) sa objavil čierny trojuholník a pri fakte 

sa objavil znak reprezentujúci kardinalitu jeden alebo viacero záznamov. V tabuľke faktov je cudzí 

kľúč zapísaný a na začiatku stĺpca s cudzím kľúčom je písmeno F. Rovnako postupujeme aj pri 

prepájaní zvyšných tabuliek. 

 

Obr. 23 Vygenerovaný cudzí kľúč 
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2.3.5. Transformácia na logický model 

Logický model môžeme samostatne vytvoriť (ak nemáme fyzický model) alebo ho vygenerujeme 

z fyzického modelu. Na vygenerovanie stačí v hornom menu kliknúť na ikonu Engineer to Logical 

Model (dvojitá šípka) alebo v prehliadači klikneme pravým tlačidlom na vyvolanie menu 

a vyberieme rovnako pomenovanú možnosť.  

 

Obr. 24 Generovanie logického modelu – spôsob č. 1 

 

Obr. 25 Generovanie logického modelu – spôsob č. 2 

Otvorí sa nové okno v ktorom vieme skontrolovať alebo vybrať, ktoré objekty sa použijú pre 

transformovanie do logického modelu. Potom len klikneme na Engineer.  

Podobne vieme vytvoriť z logického modelu fyzický model. Jediný rozdiel je, že v prehliadači 

klikneme na logický model, pravým tlačidlom vyvoláme menu a vyberieme Engineer to Relational 

Model alebo v hornom menu klikneme na symbol dvojitej šípky, smerujúcej vpravo. 
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Obr. 26 Editácia objektov pri generovaní modelu 

2.3.6. Tlač modelov 

Pred exportom môžeme v okne dátového modelu kliknúť pravým tlačidlom a vybrať možnosť 

Resize to Visible na automatické upravenie vzhľadu. Vizuálny export logického alebo fyzického 

modelu získame, ak v hornom menu vyberieme File → Data Modeler → Print Diagram a vyberieme 

si typ súboru aký potrebujeme. Pre fyzický model je postup rovnaký. 

 

Obr. 27 Tlač modelu 
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2.3.7. Generovanie DDL skriptu 

Pred exportom sa prepneme do fyzického modelu. Na exportovanie máme viacero možnosti. Prvá 

možnosť sa nachádza v hornom menu ako tretia ikona od konca s popisom Generate DDL. 

 

Obr. 28 Generovanie DDL – spôsob č. 1 

V novom okne si nastavíme parameter, verziu databázy. Spustenie DDL staršej verzie by nemal byť 

problém aj na novšej verzií ale radšej konzultuj s cvičiacim. Následne stlačíme Generate. Otvorí sa 

nové okno v ktorom stačí stlačiť Ok. DDL skript vieme skopírovať, upraviť alebo uložiť kliknutím na 

Save. 

 

Obr. 29 Editácia DDL 
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Druhá možnosť je označiť fyzický model kurzorom resp. stlačením kombinácie kláves Ctrl + A, potom 

pravým tlačidlom myši vyvoláme menu a vyberieme možnosť DDL Preview. Nevieme ale zmeniť 

verziu databázy ani exportovať skript do súboru, vieme len editovať a skopírovať skript. 

 

Obr. 30 Generovanie DDL - spôsob č. 2 

 

Obr. 31 Náhľad DDL skriptu 

Pomocou DDL skriptu vieme spätne importovať model (File → Data Modeler → Import → DDL File), 

ak sa nám poškodí alebo stratíme súbor s príponou dmd. 
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2.4. Pripojenie a tvorba databázy 

Táto časť pozostáva z vytvorenia pripojenia k databáze, vytvorenia databázy pomocou DDL resp. 

SQL skriptu a nakoniec vloženia dát do vytvorenej databázy. Budeme pracovať v programe Oracle 

SQL Developer. Pripojenie na školský databázový server sa musí uskutočniť s rámci siete TUKE alebo 

s použitím VPN prístupu. Pre informácie ako nastaviť VPN prístup navštív web: 

- uvt.tuke.sk/wps/portal/uv/sluzby/vzdialeny-pristup-vpn 

2.4.1. Pridanie pripojenia do SQL Developera 

Máme viacero možnosti. Prvou možnosťou je na Welcome Page kliknúť na Create a Connection 

Manually. Druhá možnosť je v paneli Connections kliknúť na zelené + a vybrať možnosť New 

Database Connection. 

 

Obr. 32 Pridanie pripojenia 

V novom okne je potrebné vyplniť nasledovné položky: 

- Name – vlastné pomenovanie spojenia 

- Username, Password – prihlasovacie údaje 

- Hostname, Port, SID – ip adresa servera, port, inštancia databázy 

Položku Database Type necháme na Oracle, Authentication Type na Default a Connection Type na 

Basic. Pred uložením spojenia, vieme spustiť Test. Ak je všetko v poriadku, v pravom dolnom rohu 

sa objaví Status : Success. Potom stlačíme Save. Príklad vyplnených položiek vidíme na Obr. 33.   

https://uvt.tuke.sk/wps/portal/uv/sluzby/vzdialeny-pristup-vpn
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Obr. 33 Editácia spojenia 

V paneli Connections, klikneme pravým tlačidlom myši a vyberieme možnosť Connect. Ak sme 

neuložili heslo, ukáže sa okno, kde je potrebné vložiť heslo. Ak sa program pripojí k databáze, 

v paneli Connections sa ukážu položky ako Tables, Views a otvorí sa prázdny SQL Worksheet. Ak sa 

položky neukážu a vidíme len Loading... dostaneme niektorú z chýb. Pre podrobnosti o chybách 

pozri podkapitolu  Chyba! Nenašiel sa žiaden zdroj odkazov. Chyba! Nenašiel sa žiaden zdroj 

odkazov.. 

2.4.2. Tvorba databázy 

Pre vytvorenie databázy máme viacero možnosti. Jedna z možnosti je v paneli Connections kliknúť 

na Tables a z ponuky vybrať New Table. My použijeme iný postup a budeme vytvárať databázu 

pomocou DDL resp. SQL skriptu z Data Modelera. Nájdeme súbor v ktorom je uložený skript na 

vytvorenie databázy. Tento súbor otvoríme cez File → Open alebo skopírujeme a vložíme skript do 

SQL Worksheetu. 

 

Obr. 34 Spustenie skriptu na tvorbu databázy 

Skript môžeme spúšťať postupne po jednotlivých deklaráciách kliknutím na ikonu zeleného 

trojuholníka alebo stlačením kombinácie kláves Ctrl + Enter. V tomto prípade je potrebné kliknúť 
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napr. do bloku na vytvorenie tabuľky. Spustí sa všetko až po najbližšiu bodkočiarku. Druhá možnosť 

je spustiť celý skript kliknutím na druhu ikonu zľava resp. stlačením klávesy F5. Pod editorom SQL 

sa otvorí časť s názvom Script Output, kde vidíme stav vykonania príkazu. Ak nevidíme pridané 

tabuľky, v  paneli Connections pravým tlačidlom klikneme na záložku Tables, a zo zoznamu 

vyberieme možnosť Refresh. Zmeny v databáze sú uložené v tzv. transakcií. Vytvorenie tabuľky sa 

implicitne uloží, ak by sme vkladali údaje napr. pomocou INSERT ROW, potom musíme explicitne 

spustiť príkaz COMMIT na uloženie zmien. 
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Záver 

Na koniec tejto štúdie spomenieme, že pred samotnou tvorbou dátových modelov, je potrebné 

poznať subjekty a cieľové sledované oblasti. Tieto tabuľky potom budú tvoriť tabuľky dimenzií 

a faktov. Proces je jednoduchý a samotné schémy nemajú veľmi veľké odlišnosti. Na precvičenie 

tvorby dátových modelov sme použili dataset Northwind od spoločnosti Microsoft. Existuje 

množstvo iných ukážkových databáz pre potrebu precvičenia tvorby.  

  

 

 

 

 

 

 

 

 

 

 

 


